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  Trademark Notice and Certifications 
 

INTREPID, MicroPoint and MicroTrack are registered trademarks of Southwest Microwave, Inc. 
Copyright 1995 and 2014 Southwest Microwave, Inc. All rights Reserved. 
 
Windows, XP, Vista, Word and Notepad are a registered trademark of Microsoft Corporation. 
 
 
 
FCC Notice 
 
This device complies with FCC Rules Part 15. Operation is subject to the following two conditions: 
 
This device may not cause harmful interference and 
 
This device must accept interference received, including interference that may cause undesired operation. 
 
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to part 15 of the FCC Rules.  These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment.  This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications.  Operation of this equipment 
in a residential area is likely to cause harmful interference in which case the user will be required to 
correct the interference at his own expense. 
 
 
CE Notice 
 
This equipment has been designed and tested to EN61000-6-2:2005 and EN61000-6-4:2011 per Directive 
89/336/EEC. 
 
 
RoHS Compliant 

 
 

Copyright Southwest Microwave, Inc. May, 2015 
 
 

Southwest Microwave, Inc. 
9055 South McKemy Street 
Tempe, Arizona 85284-2946 

 
Tel: (480) 783-0201 
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Web: www.southwestmicrowave.com 

 

mailto:infossd@southwestmicrowave.com


  ROM II-16-N Manual    
 

 3   Version A  

 

Table of Contents 
 
1. Introduction ............................................................................................................................................ 5 

 
1.1 Basic System Requirements .............................................................................................................. 5 

 
2. Hardware ................................................................................................................................................. 5 
 

2.1 Relay Output Module II-16-N ........................................................................................................... 5 
2.2 Optional Power Supplies ................................................................................................................... 6 
2.3 Interconnections ................................................................................................................................ 6 
2.4 Typical Configuration ....................................................................................................................... 7 

 
3. Configuration Switch.............................................................................................................................. 8 
 

3.1 Introduction ....................................................................................................................................... 8 
3.2 Address Switch S2 ............................................................................................................................. 8 
3.3 Tamper Switch .................................................................................................................................. 8 

 
4. System Communications ........................................................................................................................ 8 
 

4.1 Introduction ....................................................................................................................................... 8 
4.2 System Setup Using CST II ............................................................................................................... 9 

4.2.1 Options ....................................................................................................................................... 9 
4.2.2 Edit ........................................................................................................................................... 11 
4.2.3 Language .................................................................................................................................. 11 
4.2.4 Help .......................................................................................................................................... 11 

 
5. Programming Menu ............................................................................................................................. 11 
 

5.1 CST II  Programming Screens for ROM II-16-N ............................................................................ 11 
5.1.1 System Setup Menu .................................................................................................................. 11 
5.1.2 ROM II-16-N Properties .......................................................................................................... 11 
5.1.3 Configure Controller ................................................................................................................ 11 
5.1.4 Configuration Report ............................................................................................................... 11 
5.1.5 About ........................................................................................................................................ 11 
5.1.6 Language .................................................................................................................................. 11 

 
6. Programming Functions ...................................................................................................................... 12 
 

6.1 System Setup Menu ......................................................................................................................... 12 
6.2 ROM II-16-N Properties Menu ....................................................................................................... 13 

6.2.1 Restore ROM II-16-N to Factory Default Settings .................................................................. 13 
6.2.2 Change Network Configuration ............................................................................................... 14 

6.2.2.1 Change IP Address ............................................................................................................... 14 
6.2.2.2 Change Subnet Mask ........................................................................................................... 15 
6.2.2.3 Change Gateway Address .................................................................................................... 16 
6.2.2.4 Update Network with New Settings .................................................................................... 16 

 
 



  ROM II-16-N Manual    
 

 4   Version A  

 
 
6.2.3 Assign Device Name ................................................................................................................ 16 
6.2.4 Change Relay Time Out Value ................................................................................................ 17 
6.2.5 View MAC Address and Serial Number .................................................................................. 18 
6.2.6 Backup System ......................................................................................................................... 18 
6.2.7 Restore System ......................................................................................................................... 18 
6.2.8 Relay Test................................................................................................................................. 18 
6.2.9 Dip Switch Test ........................................................................................................................ 19 

6.3 Configure Controller  ...................................................................................................................... 20 
6.4 Configuration Report  ...................................................................................................................... 20 

6.4.1 View Configutation Report ...................................................................................................... 21 
6.4.2 Download Configuration Report .............................................................................................. 21 

6.5 About ............................................................................................................................................... 21 
6.6 Languages ........................................................................................................................................ 22 
6.7 Network Port Communications ....................................................................................................... 23 

 
 
 
 

 
 
 
 
 
 



  ROM II-16-N Manual    
 

 5   Version A  

 

1.0 Introduction 
 
The Relay Output Module II-16-N (ROM II-16-N) is part of the INTREPID™ family of products. It has 
sixteen (16) relay outputs, a USB configuration port and a remote polling port. Its function is to provide relay 
output contact closures to interface with alarm monitoring devices such as alarm panels or CCTV DVR / 
matrix systems. The ROM II-16-N is part of the INTREPID Series II (IPP IIN - INTREPID Polling Protocol II 
Network) communications format. Each output has an associated LED to indicate when the contact closure has 
an alarm condition. LED’s are also provided for communications and power status. The ROM II-16-N is used 
with the Control Module II-Networked (CM II-N) system controller.  
 
Each output has a Normally Open (N.O.), a Normally Closed (N.C.) and a Common (COM) position available 
at the terminal strips on the circuit board. 
 
The ROM II-16-N communicates with the CM II-N system controller over a network connection through its 
RJ45 remote polling port. The address of the ROM II-16-N is set by a dip switch on the circuit board. The 
USB-B port is a configuration port for network parameters. 
 
The ROM II-16N operates from 10.5 to 60 VDC @ 5.0 Watts with a minimum startup current of 425mA. The 
operating current with standard power supplies are: 12 VDC @ 350mA, 24 VDC @ 185mA and 48 VDC @ 
80mA.  
 
1.1  Basic System Requirements 
 
A computer or laptop with: Windows XP™ Pro, Windows 7™ Pro or Windows 8™ Pro operating system and 
a CD, USB and Network port. The minimum PC spec is: Pentium 4 @ 2.40GHz, 1.0GB memory and 80GB 
hard drive. A USB A-B cable is required to connect from the PC to the ROM II-16-N. The Controller Setup 
Tool II (CST II) should be installed on the computer as discussed in Section 4.0. 
 
2.0 Hardware 
 
2.1  Relay Output Module II-16-N (ROM II-16-N) 
 
The ROM II-16-N is packaged in the standard INTREPID enclosure as shown in Figure 1. The dimensions are 
5.5 in H x 13.5 in W x 5 in deep (14cm H x 34.3cm W x 12.7cm D). It weighs 2.5 lbs (1.1kg). The ROM II 
circuit board can also be installed in other enclosures. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 1 – INTREPID Enclosure for ROM II-16-N 
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2.2  Optional Power Supplies 
 
12 VDC power supply: Model PS13 Power Supply operates from 85-246VAC, 47-63Hz and furnishes 13.6 
VDC at up to 2.8A. Power supplies contain automatic switchover and battery charging circuitry for optional 
standby batteries of up to 25AH. Temperature rated from 14° to 122° F (-10° to 50° C). UL, ETS, EMC, CE, 
RoHS compliant. 
 
12 VDC power supplies: Model PS40 Power Supply operates from 120 VAC, 50-60Hz, 0.5A and furnishes 
13.7 VDC at up to 1.6A. Model PS41 Power Supply operates from 220 VAC, 50-60Hz, 0.25A. Both contain 
automatic switchover and battery charging circuitry for optional standby batteries of up to 25AH and are fused 
on both input and output for maximum protection. Temperature rated from -40° to 150° F (-40° to 66° C). 
 
24 VDC power supply: Model 78B1064 operates from 120VAC to provide 24VDC at 4A with 6.5AH battery 
backup. Includes; indoor enclosure 15 x 11 x 4 in. (381 x 280 x 102mm). Temperature rated from 32° to 122° 
F (0° to 50° C). 
 
48 VDC power supplies: Model PS48 operates from 120VAC to provide 48VDC at 3A. Includes; indoor 
enclosure 14 x 12 x 4 in. (356 x 305 x 102mm). Model PS49 operates from 220VAC to provide 48VDC at 3A. 
This supply does not include enclosure. Temperature rated from 32° to 122° F (0° to 50° C). UL, CSA, TUV, 
CE compliant. 
 
2.3  Interconnections 
 
Figure 2 shows the various connection points, dip switches and diagnostic LED’s available on the ROM II-16-
N circuit board assembly.  
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Figure 2 – Relay Output Module II-16-N (ROM II-16-N) Circuit Card  
 
Figure 3 shows the typical network wiring diagram using the CM II-N as the system controller connected to a 
Relay Output Module II-16-N (ROM II-16-N). The CM II-N would be wired to the site devices and sensors 
(AIM II, ROM II-8, ROM II-16, MTP II, PM II and MicroWave 330) using RS422 communications.  
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A maximum of four (4) ROM II-16-N devices can be connected on the network. A maximum of 20 
devices can be connected to the CM II-N.  
 

  
 

Figure 3 –ROM II-16-N Communications Wiring Diagram 
 
2.4 Typical Configurations  
 
Figure 4 shows a typical configuration using a CM II-N, ROM II-16, ROM II-16-N, AIM II, PM II, MTP II 
and a Microwave Link. The Control Room has a matrix switcher, lighting control system, paging system and 
an alarm panel. A computer is required as the configuration/programming tool to set up the system. A JB70A 
Surge/Lightning protection module is shown on the outside of the control room, at the AIM II, PM II and at 
the MTP II. The CM II-N, ROM II-16, AIM II, PM II and MTP II are connected together with the RS422 
communications line. The CM II-N and ROM II-N are connected using a network cable. The Microwave Link 
alarm relay and tamper switches are wired into the AIM II. The CM II-N, ROM II-16 and ROM II-16-N are 
programmed so their relay outputs trigger inputs on the alarm panel, lighting control system, pager system and 
CCTV matrix. A UPS is also shown and is recommended for backup of the INTREPID™ products.  

  
 

Figure 4 – Typical Configuration  
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3.0 Configuration Switch 
 
3.1  Introduction 
 
There is one 8-position dip switch (SW2) on the ROM II-16-N which is labeled ADDRESS. This switch is 
used to set the address that is used for alarm polling by the Control Module II-Networked (CM II-N) 
INTREPID™ Series II controller.  
 
3.2  Address Switch SW2 
 
Switch SW2 is used to set the address of the ROM II-16-N which is used for the alarm polling by the 
INTREPID Series II controller CM II-N. The address can be set from 0 to 239. Switch SW2, as shown in 
Figure 5, is set by using the LSB (Least Significant Bit) as the binary reference starting point for address 1. 
 

 

S
W

2

87654321ON

ADDRESS

MSB LSB

 
 

Figure 5 – Address Switch SW2  
 
3.4  Tamper Switch 
 
A tamper switch located at the top of the circuit board (shown in Figure 2) is activated when the enclosure lid 
is removed. If the ROM II-16-N is installed in a different enclosure, an external tamper switch can be 
connected to the pins located immediately to the right of the on board switch. This is labelled EXT TAMP. 
The external switch should be wired so that the contacts are shorted when the enclosure is closed. 
 
4.0 System Communications 
 
4.1  Introduction 
 
To set up alarm reporting and communications hierarchy of the CM II-N, the Controller Setup Tool II (CST II) 
must be installed on the PC that will be used to configure the system. The software is provided on a CD and is 
a “drop” and “drag” or copy installation. 
 
The CST II is an application program designed to run on a standard PC or laptop running Windows XP Pro, 
Windows 7 Pro or Windows 8 Pro operating system. If using Windows XP or 7 be sure the PC has *.Net 
Framework 4.0 (x86 and x64) installed. This applies to the CST II Version B and C programs. 
 
Insert the disc into the CD drive of the computer. Locate the application software and drag or copy it to the 
desktop or any other location on the hard driver that is convenient for use. 
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Connect a USB A-B cable between a USB communications port on the PC being used and the USB-B port on 
the RCM II-16-N. 
 
Connect a network cable between the RJ45 communications port on the ROM II-16-N, the CM II-N and the 
dedicated network point. It is recommended that this be a CAT 6 shielded cable. 
  
4.2 System Setup Using CST II 
 
Open the CST II software to launch the program to the default configuration screen as shown in Figure 6. On 
the menu bar for the default screen are the Options, Edit, Languages and Help menus. 
 

   

 
  

Figure 6 – CST II Default Screen 
 
4.2.1  Options 
 
The “Options” menu opens the “Settings”, “Forced Disconnect” and “Close” functions. Selecting “Settings” 
will open the User Settings dialog box with the “Connection” and “Window” setup parameters. 
 
The “Connection” tab will allow setting the I/O source (serial or network), the source setting (com port, telnet 
port/address/IP port) and the port settings (baud rate, parity, data bits, stop bits and flow control) as shown in 
Figure 7. These are default setting and should not be changed except for the Serial Port. 
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Figure 7 – CST II Connection Tab 
 
The “Window” tab will allow setting Terminal Display Mode, Font and Color while the Scrollback will set the 
Rows, Columns and no Scrollback as shown in Figure 8. These are default setting and should not be 
changed. 
  

   
 

Figure 8 – CST II Window Tab 



  ROM II-16-N Manual    
 

 11   Version A  

4.2.2  Edit 
 
The “Edit” menu opens the “Copy”, “Paste”, “Clear” and “Form Feed” functions.  
 
4.2.3  Languages 
 
The “Languages” pull down menu allows selecting one of the seven (7) languages for the menu bar. The 
language choices are: German, English, Spanish, French, Portuguese, Russian and Chinese. 
 
4.2.4  Help 
 
The “Help” menu will list the product name, part number, build time, Southwest Microwave information, 
copyright information and an OK button. 
 

5.0 PROGRAMMING MENU  
 
The programming menus that will be displayed in the CST II are shown in section 5.1. A brief description of 
the function is inserted after the menu. Section 6.0 will cover each menu in detail for the programming of the 
ROM II-16-N. 
 
5.1  CST II Programming Screens for ROM II-16-N 
 
  5.1.1  System Setup Menu 
 

1. ROM II-16-N Properties 
2. Configure Controller 
3. Configuration Report 
4. About 
5. Language 

 
 5.1.2 ROM II-16-N Properties 

 
1. Restore ROM II-16-N to Factory Default Settings (restores factory default settings) 
2. Change Network Configuration (allows changing of network parameters)   
3. Assign Device Name (allows naming of ROM II-16-N) 
4. Change Relay Timeout Value (allows changing time when all relay drop on com fail) 
5. View MAC Address and Serial Number (allows viewing of ROM II-16-N address and ID) 
6. Relay Test (tests relays of the ROM II-16-N) 
7. Dip Switch Test (tests address switch of ROM II-16-N) 
 

 5.1.3 Configure Controller 
 

1. Change Controller IP address and Port Number (allows changing address and port) 
  
 5.1.4 Configuration Report 
 

1. View and Download Configuration Report (allows viewing and download of configuration) 
  
 5.1.5 About 
 

1. Lists software version with build date and time 
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 5.1.6 Language 
 

1. Lists available languages (English, German, French, Spanish, Portuguese, Russian and 
Chinese) 

 

6.0 PROGRAMMING FUNCTIONS 
 
6.1 System Setup Menu 
 
NOTE!  When the CM II-N has been programmed with a zone record the system will automatically start 
polling that zone record. Any alarm activity will be displayed on the CST II and by the relay(s) 
assignment(s). Selecting “ESC” will return to previous menu without saving any changes. 
 
After the CST II has been configured and opened, all the devices communications wiring connected and 
verified and power has been applied, hit any key to open the System Setup Menu screen as shown in Figure 9. 
 

  

  
 

Figure 9 – System Setup Menu 
 
The System Setup Menu screen as well as all subsequent screens will have a banner as shown in Figure 9. The 
banner will display: 
 

• Relay Output Module II-16-N – A member of the INTREPID™ family: product model connected 
• Copyright information 
• Device Name: 
• Main >: displays what menu is currently selected 

 
The bottom of the screen will display the RX and TX status light for when information is programmed, report 
downloads, the line location, display mode and the communications port being used. 
 
From this System Setup Menu screen all programming of the ROM II-16-N will be performed. Selecting the 
appropriate command number (1-5) will open the various menu functions for programming and reviewing the 
data of the ROM II-16-N. Entering the number will open the requested menu. Selecting “ESC” will return to 
the previous menu. 
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6.2 ROM II-16-N Properties Menu  
 
Selecting “1” from the Main Menu will open the “ROM II-16-N Properties” menu as shown in Figure 10. 
There will be seven (7) command selections available. 
 

  
  
 

Figure 10 – ROM II-16-N Properties Menu 
 
6.2.1 Restore ROM II-16-N to Factory Default Settings 
 
Selecting command 1 will open the “Restore ROM II-16-N to Factory Default Settings” screen as shown in 
Figure 11.  This menu is used to erase all data in the ROM II-16-N and restore it to the factory default settings. 
A warning will be displayed. Note: This will stop all alarm polling and reporting! 
 

  

  
  

 
Figure 11 – Restore ROM II-16-N to Factory Default Settings  
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It is recommended that this function be performed for any new installation before any data entry is to be made. 
This will ensure that any miscellaneous data from previous use or any factory testing data is removed and only 
current data for the new installation found in the system. This also applies to any network settings. 
 
Select “Y” for “Yes” and press “Enter”. A prompt will ask “Are you sure you want to restore default settings? 
(Y/N) Select “Y” for “Yes” and press “Enter”. Another prompt will ask “Do you want to keep the current 
network settings? (Y/N) Select “Y” for “Yes” and press “Enter” to start the process. The screen will display 
“Erasing all configuration data, please wait”. When finished erasing it will state: “DONE”. Selecting “N” for 
“No” will end the process. 
 
The screen will then display “The system is restarting”. It will return to the main menu after it is restarted. All 
relays on the system should reset and all LED’s should be illuminated within 30 seconds. Select 1 to return to 
the ROM II-16-N Properties Menu. 
 
6.2.2 Change Network Configuration 
 
Selecting command 2 will open the “Change Network Configuration” screen as shown in Figure 12.  This 
menu is used to change the IP Address, Subnet Mask and Gateway Address and Update the Network with New 
Setting for the ROM II-16-N.  
 

  

  
 

Figure 12 – Network Configuration Menu 
 
6.2.2.1 Change IP Address 
 
Selecting command 1 will open the “Change IP Address” screen as shown in Figure 13. This allows setting the 
proper IP address for the ROM II-16-N to communicate with the CM II-N on the dedicated network.  
 
The line will list the Current and New address when entered. 
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Figure 13 – Change IP Address 
 
6.2.2.2 Change Subnet Mask 
 
Selecting command 2 will open the “Change Subnet Mask” screen as shown in Figure 14. This allows setting 
the proper Subnet Mask for the ROM II-16-N to communicate with the CM II-N on the dedicated network.  
 
The line will list the Current and New address when entered. 
 

  

  
 

Figure 14 – Change Subnet Mask 
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6.2.2.3 Change Gateway Address 
 
Selecting command 3 will open the “Change Gateway Address” screen as shown in Figure 15. This allows 
setting the proper Gateway Address for the ROM II-16-N to communicate with the CM II-N on the dedicated 
network.  
 
The line will list the Current and New address when entered. 
 

  

  
 

Figure 15 – Change Gateway Address 
 
6.2.2.4 Update Network with New Settings 
 
Selecting command 4 will update the network with the new IP Address, Subnet Mask and Gateway Address 
for the ROM II-16-N to communicate with the CM II-N on the dedicated network. 
 
6.2.3 Assign Device Name 
 
Selecting command 3 will open the “Assign Device Name” screen as shown in Figure 16.  This screen will 
display a Current Name field (if there has been one given from a previous time it will be displayed otherwise it 
will be blank) and New Name field that is blank. This screen allows the naming of the ROM II-16-N for 
reference. Enter an appropriate name for the ROM II-16-N (up to 64 characters long). Once entered, it will be 
displayed in the “Device Name” field in the banner.  
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Figure 16 – Assign Device Name 
 
6.2.4 Change Relay Timeout Value 
 
Selecting command 4 will open the “Change Relay Timeout Value” screen as shown in Figure 17.  This screen 
allows changing the time frame for when all relays will drop off line on the ROM II-16-N when there is no 
polling from the CM II-N. The time can be adjusted from 3 to 60 seconds. The default time is 30 seconds.  
 

  

  
 

Figure 17 – Change Relay Timeout Value 
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6.2.5 View MAC Address and Serial Number 
 
Selecting command 5 will open the “View MAC Address and Serial Number” screen as shown in Figure 18.  
This screen is used to view the MAC (Media Access Control) Address and electronic Serial Number of the 
ROM II-16-N that is being programmed. No changes can be made from this screen. 
 

  

  
 

Figure 18 – View MAC Address and Serial ID 
 
6.2.6 Backup System 
 
Selecting command 6 will open the Windows™ Directory to save a backup file of all programmed information 
in a *.txt format. Select a location to save the file on the PC hard drive or other location, provide a file name 
and “Save”. The bottom of the screen will state “Downloading File”. Once completed, the screen will state 
“File Transfer Completed”. Press any key to continue. 
 
An independent folder is recommended for all files associated with this ROM II-16-N and the site where it 
resides. 
 
6.2.7 Restore System 
 
Selecting command 7 will open the Windows™ Directory to restore a backup file of all programmed 
information. Find the location where the file was saved on the PC hard drive or other location and “Open”. 
The bottom of the screen will state “Uploading File”. Once the upload is completed it will return to the Main 
Menu. 
 
6.2.8 Relay Test 
 
Selecting command 8 will open the “Relay Test” screen as shown in Figure 19. The commands on this screen 
will allow setting and clearing of a single relay or all relays of the ROM II-16-N as a verification test.  
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Figure 19 – Relay Test 
 
Selecting “Relay Test” command 1 will set a single relay output on the ROM II-16-N. Enter the relay number 
to be set and press “Enter”. That relay and the associated LED will activate (the LED will turn on). Select 
“Relay Test” command 2, enter the relay number and press “Enter” to clear the relay output. Selecting 
command 3 will set all relay outputs of the ROM II-16-N. Command 4 will clear all the relay outputs. 
 
If no testing is being performed the Relay Test will self terminate in 1 minute and return to the ROM II-16-N 
Properties Menu. 
 
6.2.9 Dip Switch Test 
 
Selecting command 9 will open the “Dip Switch Test” screen as shown in Figure 20. The command on this 
screen will allow setting the address switch of the ROM II-16-N as a verification test. If the switch position is 
“On” it will display a 1. If the switch position is “Off” it will display a 0. 
 

  

  
 

Figure 20 – Dip Switch Test 
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6.3 Configure Controller  
 
Selecting “2” from the Main Menu will open the “Configure Controller” menu as shown in Figure 21. This 
screen will be used to configure the controller IP Address and Port Number by selecting 1. 
 

  

  
 

Figure 21 – Configure Controller 
 
6.4 Configuration Report 
 
Selecting “3” from the Main Menu will open the “Configuration Report” menu as shown in Figure 22. This 
screen will be used to view and download the configuration of the ROM II-16-N. 
 

 

  
 
 Figure 22 – Configuration Report 

  

  



  ROM II-16-N Manual    
 

 21   Version A  

 
6.4.1 View Configuration Report 
 
Selecting command 1will open the “View Configuration Report” screen as shown in Figure 23. This screen 
will display the configuration information of the ROM II-16-N. 
 

  

  
 
 Figure 23 – Configuration Report Information 
 
6.4.2 Download Configuration Report 
 
Selecting command 2 will open the Windows™ Directory to save a backup file of the Configuration Report in 
a *.txt format. Select a location to save the file on the PC hard drive or other location, provide a file name and 
“Save”. The bottom of the screen will state “Downloading File”. Once completed, the screen will state “File 
Transfer Completed”. Press any key to continue. 
 
An independent folder is recommended for all files associated with this ROM II-16-N and the site where it 
resides. 
 
6.5 About 
 
Selecting “4” from the Main Menu will open the “About” screen as shown in Figure 24. The about screen will 
list the Software Version, Build Time and Build Date. 
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Figure 24 – About 
 
6.6 Languages 
 
Selecting “5” from the Main Menu will open the “Languages” screen as shown in Figure 25. The screen will 
allow selecting one of the seven (5) available languages: English, German, French, Spanish, Portuguese, 
Russian or Chinese. 
 

  

  
 

 Figure 25 – Languages 
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6.7 Network Port Communications 
 
The RJ45 port will be used to poll the ROM II-16-N from the CM II-N to report and set relays for alarm 
activity. 
 
To verify that the port on the ROM II-16-N is active use the “Ping” function of the PC’ “cmd” prompt. Enter 
“cmd” into the PC’s run menu to open the DOS command. Type “Ping” followed by the IP address of the 
ROM II-16-N to send and receive data packets. If communicating you will have an equal number of sent and 
received packets and speed of delivery. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


